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1 INTRODUCTION

1.1 Introduction to the Program

ADR-1/60 is a program designed for configuring the RAD-60 Personal Alarm
Dosimeter.

The user interface operates under the Microsoft Windows environment. The program
cannot be used with the keyboard alone, a mouse is necessary at some functions.
Before using this manual, you need to know the fundamentals of using Windows.  If
you need to review windows techniques, consult the documentation that comes with
Microsoft Windows.

1.2 Installing the ADR-1 Reader Head

Connect the RS-232 cable to the ADR-1 reader head and to the communication port
of the computer (either to COM1 or COM2).  You can choose the communication port
to be used from the Options Menu in the ADR-1/60 program.  Choose the desired
port and click the Save button.  Connect the ADR-1 reader head power supply to the
mains.  When installing the hardware it is adviseable to shut down the PC.

RADOS

RS-232 cable
ADR-1 reader head

ADR-1 power supply

Figure 1.  The ADR-1/60 system configuration.
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1.3 Installing the Program

Windows software must be installed before you can start using RADOS ADR-1/60 program.

Installation:
• Start Microsoft Windows
• Put ADR-1/60 setup disk in your floppy drive.  Normally, this is Drive A.
• Select  the Run command from the File menu in the Program Manager in

Microsoft Windows.
• Type A:\SETUP and click OK or press Enter
• Follow the instructions at the setup screen and the program will be installed to

your fixed disk
• ADR-1/60 setup program builds the ADR-1/60 Program Group for you when the

install program finishes.  The program group looks like this:

Figure 2.  The ADR-1/60 Program Group.

1.3.1 ADR-1/60 Program Files

ADR-1/60 program uses the following files in the ADR1_60 directory:

ADR1_60.EXE
ADR-1/60 program file.

ADR1_60.INI
ADR-1/60 general settings file (COM port and printer settings).

ADR1_60P.INI
ADR-1/60 password file.

ADR1_60.STG
ADR-1/60 Quick Configuration settings file.
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1.4 Starting the Program

Start ADR-1/60 simply by double-clicking the ADR-1/60 icon in the ADR-1/60
Program Group.  When you start the program the Insert Dosimeter window will be
displayed automatically.
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When you insert the dosimeter ADR-1/60 window will be displayed.
The screen (figure 3 or figure 4) depends from the version of the dosimeter.

Figure 3.  The ADR-1/60 program window.

There are two lines at the bottom of the display that shows the data communication
between the computer program and RAD-60 dosimeter.
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Figure 4.  The ADR-1/60 program window.

There are two lines at the bottom of the display that shows the data communication
between the computer program and RAD-60 dosimeter.

1.5 Reading the Dosimeter

Put the dosimeter in the reader head  slot.  After a while the dosimeter display
changes to show .  The -display indicates that the dosimeter is in the in the
reader head.  The  will come into display of RAD-60 even when the RS-232
cable is not connected, if the ADR-1 power supply has been connected to mains.



2096 3620   v.2.0   16.11.95

ADR-1/60 v.2.0 6

2 USING THE ADR-1/60 PROGRAM

2.1 ADR-1/60 System Commands

In the ADR-1/60 main window there is a menu bar with the following commands:

Figure 4.  ADR-1/60 system menu bar.

File menu

Includes only Exit command for closing the program.

RAD-60 menu

When you choose Configure command from the ADR-1/60 menu, the
Configuration window will be opened (see chapter 2.2).

Options menu

In the Options menu there are the following commands:

Settings
When you choose Settings command from the Options menu, the following
window will appear.

Figure 5.  Settings window.
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In this window you can choose the printer name and the communication port of
the computer that is used for communicating with the ADR-1 reader.  Choose
the desired port and set the printer name.  The printer name is the name of your
printer device (LPT1, LPT2 or LPT3) or the data file name.  By entering a printer
name which is longer than 4 characters the printings will be directed to a file.
Click Save button to save the settings.  Click Cancel button if you want to
cancel the changes and close the window

Change Password

When you choose Change Password command from the Options menu, the
following window will appear.

Figure 6.  Change Password window.

In this window you can change the system password.  The default system
password is ”NONE”, which means that the password checking is not activated.
When a new password is entered the system asks you to verify it.  If the
password is set to any other value than ”NONE” the password protection is
activated.

Click Cancel if you want to cancel the changes and close the window.
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Help menu

About
When you choose About command from the Help menu, the About window will
appear.

Figure 7.  About ADR-1/60 window.
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2.2 Configuration Window

The configuration window is presented in the figure below.  The window displays
automatically all the configuration information of the dosimeter.  You can change the
configuration to meet the users requirements by choosing the options you want to
include in the dosimeter.

Quick
Configuration

Calibration

Alarmlevel
Setting

Button Bar

Configu-
ration

Test
Status

RAD ID

Figure 8.  The Configuration window.

On the configuration window there are following sections available:

2.2.1  Button Bar

This section includes the commonly used command buttons.

Read
Click the Read button to re-read the configuration settings of the dosimeter.

Write
If you want change the configuration settings of the dosimeter, select the desired
alternatives and click the Write button to send the new settings to the dosimeter.  The
settings are not stored in the dosimeter memory until you click the Write button.  If
you click the Read button instead of the Write button, the program restores the old
configuration settings.
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Reset Dose
If you want to clear the dose of the dosimeter, click the Reset Dose button.

Print
If you want print the configuration data click the Print button. The configuration of the
dosimeter will be printed on the selected printer or to a file (see Settings menu).
Printing is possible only when there is a dosimeter inserted in the ADR-1 reader head
slot.

Figure 9.  The RAD-51 configuration printout.

FF
To give a form feed command to the printer click the FF button.

Close
If you want to close the Configuration window click the Close button.  To re-open the
window select Configure from the RAD-60 menu.  To exit from the ADR-1/60
program, choose Exit from the file menu.

2.2.2  Calibration

This section includes Units option buttons, Calibration Coefficient data field and
Calibrate command button.

Units
Mark the appropriate check box to choose dose/dose rate units; Sievert (Sv units)
or Roentgen (R units).  The units of the Dose Alarm, Dose Rate Alarm and Chirp
Rate fields will be changed accordingly.
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Calibration Coeff.
The Calibration Coeff. field shows the calibration coefficient of the dosimeter and
indicates the sensitivity of the detector. Calibration coefficient is the number of
detector pulses that equals 100 µSv dose.

Calibrate
When you click the Calibrate button, the following window will appear.
Note:  The dosimeter calibration can be password protected.  If the password is set the program
will ask the password before you will be able to proceed to the calibration.

Figure 10.  Calibrate RAD-60 window.

This window is used in the RAD-60 calibration routine.  For calibration you need a
calibrator with quantum energy of 662 keV from a Cs-137 isotope source.  The
dose rate of the calibrator must be known value between 200 µSv/h (20 mR/h) and
20 mSv/h (2 R/h).

Select the unit from the RAD Units field.  Enter the dose rate of the calibrator in
the Calibration Field text box.  Click the Start Calibration button to send this
value to the dosimeter.  The dosimeter display shows text .  The dosimeter
must be put in the calibrator within 90 seconds.  The dosimeter counts pulses
corresponding to 100 µSv dose during the calibration procedure, so the calibration
time depends on the calibrator used.  For example, in the minimum field of 200 µ
Sv/h the calibration takes half an hour.  When the dosimeter has completed the
calibration procedure, it beeps and three MSB digits of the calibration coefficient
are shown in the dosimeter display for 2 seconds (in hexadecimal form).
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2.2.3  RAD ID Data

This section includes RAD Serial Number, Program Version and Dose data fields.

Serial Number
Shows the internal serial number of the dosimeter.  The serial number can be
changed, but it is not recommended.

Program version
Shows the CPU program version of the RAD-60 dosimeter.  The number shows
the program date (e.g. 060994 is Sept. 6, 1994).  This number cannot be changed.

Dose
Shows the dose of the dosimeter in µSv or in mR.  The dose can be cleared by
using the Reset Dose command button.

2.2.4  Configuration Data

This section includes RAD configuration data for the display, chirper and for the
button functions.

Default Display
Mark the appropriate check box to choose the display mode of the dosimeter.  You
can select either Dose or Dose rate display.

Chirper Enabled
Mark the check box to enable the chirper function.

Chirp rate
Choose the desired chirp rate from the option group.  The units shown are defined
in the Units field.  NOTE ! Setting this option has no influence on dosimeters with CPU version
060994 or older.

Button
If the Enabled check box of the Button field is marked, you can define what
checkbox options are available for the dosimeter user.  Mark the check boxes of
the desired options.

Note:  If you mark the Chirp on/off check box, the dosimeter user can use the Chirp function even
though the check box of the Chirper field is not enabled.  The Chirp Rate values cannot be
changed by the dosimeter user even if the Chirp on/off option is marked.
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If the Button field is not enabled, the settings you have made in Default Display,
Chirper, Chirp Rate, Dose Alarm and Dose Rate Alarm apply, and they cannot be
changed by the dosimeter user.

2.2.5  Test Status

This section includes RAD Error codes and detector test result data.

Errors
If the dosimeters status is OK, the Errors field will be empty.  If there is an error
text ”Low Battery” or an error code in the Errors field, the dosimeter must be
returned for servicing.  By clicking the Errors text you can open a dropdown list of
the error codes.

The error codes are:
    1 = Calibration error
    2 = Cannot write to non-volatile memory
    3 = Detector function error
    4 = RAM memory error

Detector Test Result
In the Detector Test result field there are two 3-digit hexadecimal numbers that
show the test result of the internal detector test.  The test is done every time the
meter is switched on.  In the test 511 (=1FFh)  low amplitude and 511 high
amplitude pulses are fed to the detector.  Low amplitude pulses should not give
more than 255 (=0FFh) counts and all high amplitude pulses should give more
than 255 counts.  First test result number shows the detected low amplitude pulses
and the second test result number shows the detected high amplitude pulses (in
HEX number).  If the test fails there will be an error code in the Errors field and the
meter must be returned for servicing.

2.2.6  Alarmlevel Setting

This section includes RAD alarmlevel settings.

Dose Alarm / Dose Rate Alarm
Choose the desired Dose Alarm / Dose Rate Alarm level from the option group.
The units shown are defined in the Units field.  If the preset values are not
suitable, you can define the alarm level by selecting Custom option.  A field will
appear where you can set the new level.  If you don't want the dosimeter give an
alarm, choose No Alarm.
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2.3  Quick Configuration Window

There are four standard configurations specified in the program.  You can choose one
of the predefined configurations by clicking the desired check box.  The other fields
will be updated accordingly.  You can change the settings of the fields after you have
selected the desired configuration.

You can change the standard configuration default values by Clicking Define button
when the dosimeter is not inserted in the ADR-1 reader head (Note: If the dosimeter is in
the reader head, the Define button is disabled).  The following window will be displayed:

Figure 11.  The Quick Configuration Defaults window.

Choose the configuration type 1, 2, 3 or 4 from the Configuration Number field and
set the desired values to the data fields as described in the chapter 2.2.  The Quick
Configuration window command button functions are as follows:

Save Changes
To confirm the changes for the selected type click Save Changes button.  After
saving you can select new type and define the settings for the selected type.
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Cancel
If you want to cancel the changes you have made, click the Cancel button. You
cannot cancel the changes after you have saved them.

Close
Choose Close button to close the Quick Configuration Defaults window.

2.4 Configuration Window

The configuration window of the program is presented in the figure below.  The
window displays automatically all the configuration information of the dosimeter.  You
can change the configuration to meet the users requirements by choosing the options
you want to include in the dosimeter.

Calibration

Alarm
Setting

Button Bar

Configu-
ration

Test
Status

RAD ID

Dose &
Dose Rate

Status

ID, Work &
 Memo

Service

2.4.1  Button Bar

Same as 2.2.1.

2.4.2  Calibration

Same as 2.2.2.
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2.4.3  RAD ID Data

This section includes RAD Serial Number, Program Version, Dose, Dose Rate and
Time of Dose Rate data fields.

Serial Number
Shows the internal serial number of the dosimeter.  The serial number can be
changed, but it is not recommended.

Program version
Shows the CPU program version of the RAD-60 dosimeter.  The number shows
the program date (e.g. 060994 is Sept. 6, 1994).  This number cannot be changed.

Dose
Shows the dose of the dosimeter in µSv or in mR.  The dose can be cleared by
using the Reset Dose command button.

Dose Rate
Shows the maximum dose rate of the dosimeter in µSv/h or in mR/h.  The dose rate
can be cleared by using the Reset Dose command button.

At
Shows the time when the maximum dose rate occured. Format HH:MM:SS.

2.4.4  Configuration Data

This section includes RAD configuration data for the display, chirper and for the
button functions.

Mode
SYSTEM = System dosimeter
Stand Alone = Stand Alone dosimeter

Default Display
Mark the appropriate check box to choose the display mode of the dosimeter.  You
can select either Dose or Dose rate display. If ID is selected the dosimeter displey
will show the last 3 digits of the ID-code for 3 s every 25 s.

Chirper Enabled
Mark the check box to enable the chirper function.
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Chirp rate
Choose the desired chirp rate from the option group.  The units shown are defined
in the Units field.  NOTE ! Setting this option has no influence on dosimeters with CPU version
060994 or older.

Button
If the Enabled check box of the Button field is marked, you can define what
checkbox options are available for the dosimeter user.  Mark the check boxes of
the desired options. Grayed options may be used only with System Dosimeter.

Note:  If you mark the Chirp on/off check box, the dosimeter user can use the Chirp function even
though the check box of the Chirper field is not enabled.  The Chirp Rate values cannot be
changed by the dosimeter user even if the Chirp on/off option is marked.

If the Button field is not enabled, the settings you have made in Default Display,
Chirper, Chirp Rate, Dose Alarm and Dose Rate Alarm apply, and they cannot be
changed by the dosimeter user.

2.4.5  Test Status

This section includes RAD Error codes and detector test result data.

Errors
If the dosimeters status is OK, the Errors field will be empty.  By clicking the Errors
text you can open a dropdown list of the error codes.

The error codes are:
C = Calibration not done
G = Detector defective
L = Service counter too high
R = Error in program memory check-sum
T = Timer alarm
N = NVRAM-error
P = ‘Reset’-flag.

Detector Test Result
In the Detector Test result field there are two 3-digit hexadecimal numbers that
show the test result of the internal detector test.  The test is done every time the
meter is switched on. In the test 511 (=1FFh) low amplitude and 511 high
amplitude pulses are fed to the detector.  Low amplitude pulses should not give
more than 255 (=0FFh) counts and all high amplitude pulses should give more
than 255 counts.  First test result number shows the detected low amplitude pulses
and the second test result number shows the detected high amplitude pulses (in
HEX number).  If the test fails there will be an error code in the Errors field and the
meter must be returned for servicing.
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2.4.6  Alarmlevel Setting

This section includes RAD alarmlevel settings.

Dose Alarm / Dose Rate Alarm / Timer Alarm
Enter the desired Dose Alarm / Dose Rate Alarm / Timer Alarm level from the.
The units shown are defined in the Units field.

NOTE: Dose & Dose Rate alarmlevel resolution is three digits (1 - 999, 1010 - 9990,
10100 - 99900, ...)

2.4.7  Service Counter

The cumulative detector dose. Field can be cleared by typing RESET in the
field and clicking the ResetDose button.

2.4.8  ID, Work & Memo

ID: ID code, 10 digits.

Work: Work code, 8 digits.

Memo: Memo field, 16 characters.

2.3.9  Status

Dosimeter state.
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FEEDBACK FORM
We are continuously working hard to supply you with correct and easy-to-read technical documents.
However, complex systems are difficult to document, explain or understand, and thus sometimes
there may be mistakes or inadequacies in the documentation. To correct these errors we would like to
hear your opinion about this document.

If you have noted mistakes, or if there are parts that are unclear, please let us know. Take a copy of
this page and describe the problem and send the copy to us here in RADOS.

To: RADOS Technology Oy/Technical Documents
P.O. Box 606, FIN-20101 Turku, Finland
Fax: +358-21-468 4601

This way you help us to improve our documents and to supply you even better documents.
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